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COMPUTERFUNDAMENTALS
ComputerisanelectronicdevicethatisdesignedtoworkwithInformation.Thetermcomputer
isderivedfromtheLatinterm‗compute‟,thismeanstocalculate.Computercannotdoanything without
a Program. It represents the decimal numbers through a string of binary digits. The Word
'Computer' usually refers to the Center Processor Unit plus Internal memory.

CHARLESBABBAGE

Charles Babbage was an English polymath. He was a mathematician, philosopher, inventor
and mechanical engineer, who is best, remembered now for originating the concept of a
programmable computer.

Considereda"fatherofthecomputer",Babbageiscreditedwithinventingthefirst
mechanicalcomputer that eventually led to more complex designs. His varied work in other
fields has led him to be described as "pre-eminent" among the many polymaths of his century.
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FUNCTIONALITESOF COMPUTER:

Anydigitalcomputercarriesoutfivefunctionsingrossterms:

• Takesdataasinput.

• Storesthedata/instructionsinitsmemoryandcanusethemwhenrequired.

• Processthedataandconvertitintousefulinformation.

• Outputtheinformation.

• Controlalltheabovefoursteps.

Definition

ComputerSystemis an electronic dataprocessingdevicewhichdoesthefollowing:

• Acceptandstoreaninputdata.

• Processthedatainput.

• Andoutputtheprocesseddatainrequiredformat.

ADVANTAGESOFCOMPUTER:

FollowinglistdemonstratestheadvantagesofComputers: High Speed

• Computerisaveryfastdevice.

• Itiscapableofperformingadditionofverybigdata.

• Thecomputerhasunitsofspeedinmicrosecond,nanosecondandeventhe picoseconds.

• It can perform millions of calculations in a few seconds as compared to man who can
spend many months for doing the same task.

Accuracy

• Inadditiontobeingveryfast,computerisveryaccurate.

• Thecomputercanperformcalculations100%errorfree.



• Computersperformalljobswith100%accuracy.

StorageCapability

• Memoryisaveryimportantcharacteristicofacomputer.

• Thecomputerhasmuchmorestoragecapacitythanhumanbeings.

• Itcanstorelargeamountofdata.

• Itcanstoreanytypeofdatasuchasimages,videos,text,audioandanyothertype.

Diligence

• Unlikehumanbeings,acomputerisfreefrommonotony,tirednessandlackof concentration.

• Itcanworkcontinuouslywithoutcreatinganyerrorandboredom.

• Itcandorepeatedworkwithsamespeedandaccuracy.

Versatility

• Acomputerisaveryversatilemachine.

• Acomputerisveryflexibleinperformingthejobstobedone.

• Thismachinecanbeusedtosolvetheproblemsrelatingtovariousdifferentfields.
• Atoneinstant,itmaybesolvingacomplexscientificproblemandtheverynextmoment it may

be playing a card game. Reliability

• Acomputerisareliablemachine.

• Modernelectroniccomponentshavefailurefreelonglives.

• Computersare designedto makemaintenance easy.

Automation

• Computerisanautomaticmachine.

• Automationmeansabilitytoperformthetaskautomatically.

• Onceaprogramisgiventocomputeri.e.storedincomputermemory,theprogramand
instruction can controlthe program execution without human interaction.

ReductionInPaperWork



• Theuseofcomputersfordataprocessinginanorganizationleadstoreductioninpaper work
and speeds up the process.

• Asdatainelectronicfilescanberetrievedasandwhenrequired,theproblemof maintenance of
large number of files gets reduced.

Reduction In Cost

• Thoughtheinitialinvestmentforinstallingacomputerishighbutitsubstantiallyreduces the
cost of each of its transaction.

DISADVANTAGESOFCOMPUTER:

FollowinglistdemonstratesthedisadvantagesofComputersintoday'sarena.

• Acomputerisamachineandhasnointelligenceofitsowntoperformanytask.

• Eachandeveryinstructionhastobegiventothecomputer.

• Acomputercannottakeanydecisiononitsown.
Dependency

• Itcanperformfunctionasinstructedbytheuser,soitisfullydependentonhumanbeing.

Environment

• Theoperatingenvironmentofcomputershouldbedustfreeandsuitabletoit.NoFeeling

• Computerhasnofeelingoremotions.

• It cannot make Judgment based on feelings, tastes, experiences and knowledge unlike
a human being.

APPLICATIONSOFCOMPUTER

Banking

TodayBankingisalmosttotallydependentoncomputer. Banks

provide following facilities:

• Banks on-line accounting facility, which include current balances, deposits, overdrafts,
interest charges, shares and trustee records.

• ATMmachinesaremakingiteveneasierforcustomerstodealwithbanks.



Insurance

Insurance companies are keeping all records up to date with the help of computer. The
InsuranceCompanies,FinancehousesandStockbrokingfirmsarewidelyusingcomputersfor their
concerns.

InsuranceCompaniesaremaintainingadatabaseofallclientswithinformationshowing

• howtocontinuewithpolicies

• startingdateofthepolicies

• nextdueinstallmentofapolicy

• maturitydate

• interestsdue

• survivalbenefits

• bonus

Education

ThecomputerhasprovidedalotoffacilitiesintheEducationSystem.

• The uses of computer provide a tool in the Education system is known as CBE
(Computer Based Education).

• CBEinvolvesControl,DeliveryandEvaluationoflearning.

• The computer education is very familiar and rapidly increasing the graph of computer
students.

• There are number of methods in which educational institutions can use computer to
educate the students.

• It is used for prepare a database about student performance and analysis are carried
out.

Marketing

InMarketingusesofcomputerarefollowing:
• Advertising: With computers, advertising professionals create art and graphics, write

and revise copy and print and disseminate ads with the goal of selling more products.
• At Home Shopping: At home shopping has been made possible through use of

computerized catalogues that provide access to product information and permit direct
entry of orders to be filled by the customers.

HealthCare

ComputershavebecomeimportantpartinallMedicalSystems.



The computers are being used in hospitals to keep the record of patients and medicines. It is
also usedin scanning anddiagnosing different diseases. ECG, EEG,Ultrasounds and CT Scans
etc. are also done by computerized machines.

Someofmajorfieldsofhealthcareinwhichcomputerareused:
• DiagnosticSystem:Computersareusedtocollectdataandidentifycauseofillness.
• Lab-diagnosticSystem:Alltestscanbedoneandreportsarepreparedbycomputer.
• Patient Monitoring System: These are used to check patient's signs for abnormality

such as in Cardiac Arrest, ECG etc.
• PharmaInformationSystem:Computer checks Drug-Labels, Expiry dates, harmful

drug side effects etc.

• Nowadays,computersarealsousedinperformingsurgery.

Engineering Design

Computersarewidelyusedinengineeringpurposes.

OneofmajorareasisCAD(ComputerAidedDesign).CADprovidescreation,editionand modification of
image. Some fields are:

• StructuralEngineering:Requiresstressandstrainanalysisrequiredfordesignof Ships,
Buildings, Budgets, and Airplanes etc.

• Industrial Engineering: Computers deals with design, implementation and
improvement of integrated systems of people, materials and equipments.

• ArchitecturalEngineering:Computers help in planning towns, designing buildings,
determining a range of buildings on a site using both 2D and 3D drawings.

Military
Computersarelargelyusedindefense.Moderntanks,missiles,weaponsetc.employ computerized
control systems. Some military areas where a computer has been used are:

• MissileControl

• MilitaryCommunication

• Militaryoperationandplanning

• SmartWeapons

Communication

Communicationmeansto conveya message,an idea,a picture orspeechthat isreceived and
understood clearly and correctly by the person for whom it is meant. Somemain areas in this
category are:

• E-mail

• Chatting



• Usenet

• FTP

• Telnet

• Video-conferencing

Governmentapplications

Computersplayanimportantroleingovernmentapplications.Somemajorfieldsinthiscategory are:

• Budgets

• Salestaxdepartment

• Incometaxdepartment

• Male/Femaleratio

• Computerizationofvoterslists

• ComputerizationofDrivingLicensingsystem

• ComputerizationofPANcard WeatherForecasting.

TYPESOFCOMPUTER:

Computercanbebroadlyclassifiedbytheirspeedandcomputingpower.

Sr.
No. Type Specifications

1 PC(PersonalComputer)
Singleusercomputersystem.Moderately
powerful microprocessor.

2
Singleusercomputersystem.SimilartoWorkStati

on PersonalComputerbuthavemorepowerful
microprocessor.

3 MiniComputer
Multi-user computer system. Capable of
supportinghundredsofuserssimultaneously.

4 MainFrame

Multi-user computer system. Capable of
supportinghundreds of users simultaneously.
Software technology is different from
minicomputer.



5
Supercomputer

Anextremelyfastcomputerwhichcanperform
hundreds of millions of instructions per
second.

INPUTDEVICES

FollowingarefewoftheimportantinputdeviceswhichareusedinComputerSystems

• Keyboard

• Mouse

• JoyStick

• Lightpen

• TrackBall

• Scanner

• GraphicTablet

• Microphone

• MagneticInkCardReader(MICR)

• OpticalCharacterReader(OCR)
• BarCodeReader

• OpticalMarkReader

OUTPUT DEVICES

FollowingarefewoftheimportantoutputdeviceswhichareusedinComputerSystems

• Monitors

• GraphicPlotter

• Printer

CPU(CENTRALPROCESSING UNIT)

• CPUisconsideredasthebrainofthecomputer.

• CPUperformsalltypesofdataprocessingoperations.



• Itstoresdata,intermediateresultsandinstructions(program).

• Itcontrolstheoperationofallpartsofcomputer.

CPU itself hasfollowing threecomponents.

• Memory OrStorageUnit:

• ControlUnit

• ALU(ArithmeticLogicUnit)

Memoryor Storage Unit:
Thisunitcanstoreinstruction,dataandintermediateresults.Thisunitsuppliesinformationto
theotherunitsofthecomputerwhenneeded.Itisalsoknownasinternalstorageunitormain memory
or primary storage or Random access memory (RAM).

Itssizeaffectsspeed,powerandcapability.Thereareprimarymemoryandsecondarymemory two
types of memories in the computer.

FunctionofMemoryUnitis:

Itstoresallthedatatobeprocessedandtheinstructionsrequiredforprocessing. It stores

intermediate results of processing.



Itstoresfinalresultsofprocessingbeforetheseresultsarereleasedtoanoutputdevice. All inputs

and outputs are transmitted through main memory.

Control Unit:
This unit controls the operations of all partsof computer. It does not carryout anyactualdata
processing operations.

Functionsofthisunitare

It is responsible for controlling the transfer of data and instructions among other units of a
computer.

Itmanagesandcoordinatesalltheunitsofthecomputer.

It obtains the instructions from the memory, interprets them and directs the operation of the
computer.

ItcommunicateswithInput/outputdevicesfortransferofdataorresultsfromstorage. It does

not process or store data.

ALU(ArithmeticLogicUnit):

Thisunitconsistsoftwosub-sectionsnamely

• Arithmeticsection

• LogicSection

ARITHMETICSECTION
Function of Arithmetic section is to perform arithmetic operations like addition, subtraction,
multiplication and division. All complex operations are done by making repetitive use of above
operations.

LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting, matching
and merging of data.

Unitsof Computer MemoryMeasurements

1Bit=BinaryDigit(BitsofComputerare0and1) 8 Bits
= 1 Byte
1024Bytes=1KB(KiloByte) 1024
KB= 1 MB (MegaByte)



1024MB=1GB(GigaByte)

Computer Memory
In computing,memory refers to the physical devices used to store programs (sequences of
instructions)ordata(e.g.programstateinformation)onatemporaryorpermanentbasisforuse in a
computer or other digital electronic device. The term primary memory is used for the
information in physical systems which function at high-speed (i.e. RAM), as a distinction from
secondarymemory,whicharephysicaldevicesforprogramanddatastoragewhichareslowto access
but offer higher memory capacity. Primary memory stored on secondary memory is called
"virtual memory". An archaic synonym for memory is store.
The term "memory", meaning primary memory is often (but not always) associated with
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors, used for example as primary memory but also other purposes in computers and
other digital electronic devices. There are two main types of semiconductor memory: volatile
and non-volatile. Examples of non-volatile memory are flash memory (sometimes used as
secondary,sometimesprimarycomputermemory)andROM/PROM/EPROM/EEPROM memory(used
for firmware such as boot programs). Examples of volatile memory are primarymemory
(typically dynamic RAM, DRAM), and fast CPU cache memory (typically static RAM,
SRAM,whichisfastbutenergy-consumingandofferlowermemorycapacityperareaunitthan DRAM) .

Volatile memory

Volatile memory is computer memory that requires power to maintain the stored information.
Most modern semiconductor volatile memory is either Static RAM or dynamic RAM. SRAM
retains its contents as long as the power is connected and is easy to interface to but uses six
transistors per bit. Dynamic RAM is more complicated to interface to and control and needs
regular refresh cycles to prevent its contents being lost. However, DRAM uses only one
transistorandacapacitorperbit,allowingittoreachmuchhigherdensitiesand,withmorebits on a
memory chip, be much cheaper per bit. SRAM is not worthwhile for desktop system
memory,whereDRAMdominates,butisusedfortheircachememories.SRAMiscommonplace in small
embedded systems, which might only need tens of kilobytes or less. Forthcoming
volatilememorytechnologiesthathopetoreplaceorcompetewithSRAMandDRAMinclude Z-
RAM,TTRAM,A-RAMandETARAM.

Non-volatilememory

Non-volatilememoryiscomputermemorythatcanretainthestoredinformationevenwhennot
powered. Examples of non-volatile memory include read-only memory(ROM), flashmemory,
most types of magnetic computer storage devices (e.g. hard disks,floppy discs and
magnetictape), optical discs, and early computer storage methods such as paper tape and
punchedcards.
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OPERATINGSYSTEM
Anoperatingsystemisaprogramthatactsasaninterfacebetweenthesoftwareandthe computer
hardware.

• Itisanintegrationsetofspecializedprogramsthatareusedtomanageoverallresources and
operations of the computer.

• It is specialized software that controlsandmonitors the execution of all otherprograms

that reside in the computer, including application programs and other system software.
Objectives of Operating System

• Makingacomputersystemconvenienttouseinanefficientmanner

• Tohidethedetailsofthehardwareresourcesfromtheusers

• Toprovideusersaconvenientinterfacetousethecomputersystem.

• To act as an intermediary between the hardware and its users and making it easier for
the users to access and use other resources.

• Managetheresourcesof acomputersystem.

• Keep track of who is using which resource, granting resource requests, according for
resource using and mediating conflicting requests from different programs and users.

• Theefficientandfairsharingofresourcesamongusersandprograms

CharacteristicsofOperatingSystem
• MemoryManagement--Itkeepstracksofprimarymemoryi.e.whatpartofitareinuse by

whom, what part are not in use etc. Allocates the memory when the process or
program requests it.

• Processor Management -- Allocate theprocessor (CPU)to aprocess.
De-allocate processor when processor is no longer required.

• Device Management -- Keep tracks of all devices. This is also called I/O controller.
Decides which process gets the device when and for how much time.

• File Management -- Allocates the resources. De-allocates the resources. Decides who
gets the resources.

• Security --Bymeansofpasswords&similarothertechniques,preventingunauthorized
access to programs & data.

• Jobaccounting--Keepingtrackoftime&resourcesusedbyvariousjobsand/orusers.



• Control over system performance -- Recording delays between request for a service
& from the system.

• Interaction with the operators --Theinteractionmaytakeplaceviatheconsoleofthe
computerin theform of instructions.OperatingSystem acknowledges the same, do the
corresponding action and inform the operation by a display screen.

• Error-detecting aids -- Production of dumps, traces, error messages and other
debugging and error-detecting methods.

• Coordination between other software and users -- Coordination and assignment of
compilers, interpreters, assemblers and other software to the various users of the
computer systems.

WINDOWS7

Windows 7 is an operating system produced by Microsoft for use on personal computers,
including home and business desktops, laptops, net books,tablet PCs, and media center PCs.
It was released to manufacturing on July 22, 2009, and became generally available retail
worldwide on October 22, 2009, less than three years after the release of its predecessor,
Windows Vista. Windows 7's server counterpart, Windows Server 2008 R2, was released atthe
same time. Windows 7 is succeeded by Windows 8.

UnlikeWindows Vista's many newfeatures,Windows 7 was an incremental upgrade designed to
work with Vista-compatible applications and hardware. Presentations given by Microsoft in
2008 focused on multi-touch support, an updatedWindows shell with a new taskbar, referred
to internally as the Superbar, a home networking system called Home Group, and
performance improvements. Some standard applications that have been included with prior
releases of Microsoft Windows, including Windows Calendar,Windows Mail,Windows
MovieMaker, and Windows Photo Gallery, are not included in Windows 7; most are instead
offered separately at no charge as part of the Windows Essentials suite.

InstallWindows7

Many people have computers that come with Windows 7 so they may never have to install it.
However, you may need to install Windows 7 if:

• YoureplacedyourharddiskdrivewithanewharddiskdrivethatdoesnothaveWindows 7
installed.

• You are reinstallingWindows 7 on a computer because you want to clean off your hard
drive and remove any unwanted programs, such as spyware.

• Youpurchasedacomputerwithoutanoperatingsystem.

Pre-installation checklist

Beforeyoubegintheinstallationprocess,usethischecklisttomakesurethatyouareprepared:
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• YouhavetheWindows7CD.
• You have the product key available. The product key is located on your Windows 7 CD

case and is required to install and activate Windows 7.
• Your computer hardware is set up. At a minimum, you should connect your keyboard,

mouse,monitor,andCDdrive.Ifavailable,youshouldconnectyourcomputertoawired network.
• YouhaveWindows7driversavailable.DriversaresoftwarethatWindows7usesto

communicatewithyourcomputer‘shardware.Ifyoudonothavedriversavailable, Windows 7
mayalreadyinclude drivers for your hardware. If not, you should be able to download
them from your hardware manufacturer‘s website after you set upWindows
7.

• If you are reinstalling Windows 7 on an existing computer, you need a backup copy of
your files and settings. The installation process will delete all of your files. You can use
theFileandSettingsTransferWizardtostoreyourfilesandsettingsonremovablemedia and
then restore them after installation is complete.

Installation process

InstallingWindows 7 can take up to two hours. To make the process moremanageable, ithas
been broken up into several sections.

ToBeginInstallation:

1. InserttheWindows7CDintoyourcomputerandrestartyourcomputer.
2. IfpromptedtostartfromtheCD,pressSpacebar.Ifyoumisstheprompt(itonlyappears for a

few seconds), restart your computer to try again.
3. Windows7Setupbegins.Duringthisportionof setup,yourmousewillnotwork,soyou must use

the keyboard. On the Welcome to Setup page, press Enter.
4. On the Windows 7 Licensing Agreement page, read the licensing agreement. Press the

Page Down key to scroll to the bottom of the agreement. Then press F8.
5. ThispageenablesyoutoselecttheharddiskdriveonwhichWindows7willbeinstalled.

Onceyoucompletethisstep,alldataonyourharddiskdrivewillberemovedandcannot
berecovered.Itisextremelyimportantthatyouhavearecentbackupcopyofyourfiles before
continuing. When you have a backup copy, press D, and then press L when prompted.
This deletes your existing data.

6. PressEntertoselectunpartitionedspace, which appearsbydefault.
7. Press Enter again to select Format the partition using the NTFS file system, which

appears by default.
8. Windows7erasesyourharddiskdriveusingaprocesscalledformattingandthencopies the

setup files. You can leave your computer and return in 20 to 30 minutes.

ToContinuethe Installation

1. Windows 7 restarts and then continues with the installation process. From this point
forward, you can use yourmouse. Eventually, the Regionaland Language Optionspage
appears. Click Next to accept the default settings. If you are multilingual or prefer a
language other thanEnglish, you can changelanguage settings after setup is complete.



2. On the Personalize Your Software page, type your name and your organization name.
Some programs use this information to automatically fill in your name when required.
Then, click next.

3. On the Your Product Key page, type your product key as it appearson yourWindows 7
CD case. The product key is unique for every Windows 7 installation. Then, click Next.

4. On the Computer Name and Administrator Password page, in the Computer name box,
type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect your
computertoa network, you will use this computer name tofind sharedfilesand
printers.Type a strongpasswordthat you can rememberintheAdministratorpassword box,
and then retype itin the Confirm password box.Write the password down and store it in
a secure place. Click Next.

5. On the Date and Time Settings page, set your computer‘s clock. Then, click the
TimeZone down arrow, and select your time zone. Click Next.

6. Windows 7 will spend about a minute configuring your computer. On the
NetworkingSettings page, click next.

7. OntheWorkgrouporComputerDomainpage,clickNext.

To complete the installation

1. Windows7willspend20or30minutesconfiguringyourcomputerandwillautomatically restart
when finished. When the Display Settings dialog appears, click OK.

2. WhentheMonitorSettingsdialogboxappears,click OK.
3. Thefinalstageofsetupbegins.OntheWelcometoMicrosoftWindowspage,clickNext.
4. OntheHelpprotectyourPCpage,clickHelpprotectmyPCbyturningonAutomatic Updates now.

Then, click Next.
5. Windows7willthencheckifyouareconnectedtotheInternet:

o If you are connected to the Internet, select the choice that describesyour
networkconnectionontheWillthiscomputerconnecttotheInternetdirectly,or
through anetwork page. If you‘renot sure,accept thedefault selection,and click
Next.

o If you use dial-up Internet access, or if Windows 7 cannot connect to the
Internet,youcanconnecttotheInternetaftersetupiscomplete.OntheHowwill this
computer connect to the Internet? Page, click Skip.

6. Windows7SetupdisplaystheReadytoactivateWindowspage.If youareconnectedto
theInternet,clickYes,andthenclickNext.IfyouarenotyetconnectedtotheInternet, click No,
click Next, and then skip to step 24. After setup is complete, Windows 7 will
automatically remind you to activate and register your copy of Windows 7.

7. OntheReadytoregisterwithMicrosoftpage,clickYes,andthenclickNext.
8. OntheCollectingRegistrationInformationpage,completetheform.Then,clickNext.
9. OntheWhowillusethiscomputerpage,typethenameofeachpersonwhowillusethe computer?

You can use first names only, nicknames, or full names. Then click Next.
10.OntheThankyou!Page,clickFinish.

Windows 7 setup is complete. You can log on by clicking your name on the logon
screen. If you‘ve installedWindows 7 on a new computer or new hard disk drive, you
cannowusetheFileandSettingsTransferWizardtocopyyourimportantdatatoyour computer
or hard disk drive.



MS-DOS

Short for Microsoft Disk operating system, MS-DOS is a non-graphical command line
operatingsystemderivedfrom86-DOSthatwascreatedforIBMcompatiblecomputers.MSDOS
originally written by Tim Peterson and introduced by Microsoft in August 1981 and was last
updatedin1994whenMS-DOS6.22wasreleased.Today,MS-DOSisnolongerused;however, the
command shell, more commonly known as the Windows command line is still used by many
users.

Today,mostcomputerusersareonlyfamiliarwithhowtonavigateMicrosoftWindowsusingthe mouse
Unlike Windows, MS-DOS is a command-line and is navigated by using MS-DOS commands.
For example, if you wanted to see all the files in a folder in Windows you would double-click
the folder to open the folder in Windows Explorer. In MS-DOS, to view that same
folderyouwouldnavigatetothefolderusingtheCDcommandandthenlistthefilesinthatfolder using the
dir command.

DOS Commands

MS-DOShasarelativelysmallnumberofcommands,andanevensmallernumberofcommonly used
ones. Moreover, these commands are generally inflexible because, in contrast to Linux and
other Unix-like operating systems, they are designed to accommodate few options or
arguments(i.e., values that can be passed to the commands).

Some of the most common commands are as follows (corresponding commands on Unix-like
operating systems are shown in parenthesis):

CD-changesthecurrentdirectory(cd)
COPY - copies a file(cp)
DEL-deletesa file(rm)
DIR-listsdirectorycontents(ls)
EDIT-startsaneditortocreateoreditplaintextfiles(vi,vim,ed,Joe) FORMAT
- formats a disk to accept DOS files (mformat)
HELP-displaysinformationaboutacommand(man,info) MKDIR -
creates a new directory (mkdir)
RD-removesadirectory(rmdir) REN
- renames a file (mv)
TYPE-displayscontentsofafileonthescreen(more,cat)

OtherDOSCommand commonlyused are:
Append
Theappendcommandcanbeusedbyprogramstoopenfilesinanotherdirectoryasiftheywere located in
the current directory.
Attrib
Theattribcommandisusedtochangetheattributesofasinglefileoradirectory.
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Break
ThebreakcommandsetsorclearsextendedCTRL+Cchecking.Call
The call command is used to run a script orbatch program from within another script orbatch
program.
Thecallcommandhasnoeffectoutsideofascriptorbatchfile.Inotherwords,runningthe call
command at the DOS prompt will do nothing. Chcp
Thechcp command displaysorconfigures the active codepage number.
Chdir
The chdircommand isusedtodisplaythedrive letter andfolder thatyou are currentlyin.
Chdircanalsobeusedtochangethedriveand/ordirectorythatyouwanttoworkin.Chkdsk The
chkdsk command,often referred to as check disk, isused to identifyand correct certain hard
drive errors. Choice
The choice command is used within a script or batch program to provide a list of choices and
return the value of that choice to the program.
Cls
Theclscommandclearsthescreenof allpreviouslyenteredcommandsandothertext.
Dir
Thedircommandisusedtodisplayalistoffilesandfolderscontainedinsidethefolderthatyou are
currently working in.
Thedircommandalsodisplaysotherimportantinformationliketheharddrive'sserialnumber,
thetotalnumberoffileslisted,theircombinedsize,thetotalamountoffreespaceleftonthe drive, and
more.
DIR[drive:][path][filename][/P][/W][/A[[:]attributes]][/O[[:]sortorder]][/S][/B][/L][/V]

[drive:][path][filename]
Specifiesdrive,directory,orfilestolist.(Couldbeenhancedfile

specificationormultiplefilespecs)
/P Pauses aftereachscreenful ofinformation.
/W Useswidelistformat.

attributes:D
Directories
RRead-onlyfiles

/A HHiddenfiles
AFilesreadyforarchiving S
System files
-Prefixmeaningnot

/O Listbyfilesinsortedorder,sortorder: N

By name (alphabetic)
SBysize(smallestfirst)
EByextension(alphabetic)
DBydateandtime(earliestfirst) G
Group directories first
-Prefixtoreverseorder
AByLastAccessDate(earliestfirst)

/S Displaysfilesinspecifieddirectoryandallsubdirectories.

http://www.computerhope.com/jargon/m/multfile.htm


/B Usesbareformat(noheadinginformationorsummary).
/L Useslowercase.
/V Verbosemode.

MS- PAINT
Paintisadrawingtoolyoucanusetocreatesimpleorelaboratedrawings.Thesedrawingscan
beeitherblack-and-whiteorcolor,andcanbesavedasbitmapfiles.Youcanprintyourdrawing, use
itforyourdesktopbackground, orpaste itintoanotherdocument. You caneven usePaint to view
and edit scanned photos.

You can also use Paint to work with pictures, such as .jpg, .gif, or .bmp files. You can paste a
Paint picture into another document you've created, or use it as your desktop background.

Todrawastraightline
1. Inthetoolbox,clickLine .
2. Belowthetoolbox,clickalinewidth.
3. Dragthepointertodrawtheline.

Todraw a freeformline
1. Inthetoolbox,clickLine .
2. Dragthepointertodrawtheline.

Todraw acurvedline
1. Inthetoolbox,clickCurve .
2. Belowthetoolbox,clickalinewidth.
3. Drawastraightlinebydraggingthepointer.
4. Click where you want one arc of the curve to be, and then drag the pointer to adjust

thecurve. Repeat this step for a second arc. You can only create two curves for each line.

Tosend animageusing e-mail
Afteryouaredoneworkingonanimage,youcansendittoanyonewhohasane-mailaccount (as long as
you also have access to an e-mail account).
1. OntheFilemenu,clickSend.
2. Youre-mailprogramwilldisplay,withyourimageincludedeitherasanattachmentoraspart of the

message section of your e-mail.
3. Specify your recipient's e-mail address, a subject, and a message; then send the e-mail as

you normally would.
Todraw arectangleorsquare
1. In the toolbox, click Rectangle to create a square-cornered shape, or

clickRoundedRectangle to create a round-cornered shape.
2. Belowthetoolbox,clickafillstyle.
3. Todrawarectangle,dragthepointerdiagonallyinthedirectionyouwant.
4. Todrawasquare,holddownSHIFTwhiledraggingthepointer.



Toacquireanimagefromascanneroradigitalcamera 1. On the
File menu, click From Scanner or Camera.
2. IntheGetPicturesdialogbox,clicktheimageyouwant,andthenclickGetPicture.

NOTEPAD

Notepadoverview
NotepadisabasictexteditoryoucanuseforsimpledocumentsorforcreatingWebpages.The
mostcommonuseforNotepadistovieworedittext(.txt)files,butmanyusersfindNotepada simple tool
for creating Web pages.
Because Notepad supports only very basic formatting, you cannot accidentally save special
formatting in documents that need to remainpure text. This is especially useful when creating
HTML documents for a Web page because special characters or other formatting may not
appear in your published Web page or may even cause errors.
You can save your Notepad files as Unicode, ANSI, UTF-8, or big-endian Unicode. These
formatsprovideyougreaterflexibilitywhenworkingwithdocumentsthatusedifferentcharacter sets.
WORDPAD

WordPad is a basic word processor that is included with almost all versions of Microsoft
Windows from Windows 95 onwards. It is more advanced than Notepad but simpler than
Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft Write.

UsingWordPad
WordPadisabasicwordprocessorthatisincludedinWindows.Awordprocessorisacomputer program
that you can use to create, edit, view, and print text documents. With WordPad, you can type
letters,bookreports, and othersimple documents. You can also change howthetext looks,
quickly move sentences and paragraphs around, and copy and paste text within and between
documents.

TheWordPadwindow
To open WordPad, click the Start button , click All Programs, click Accessories, and then
click WordPad.

TherearefourmainpartsoftheWordPadwindow:

The toolbar: The toolbar contains buttons for basic commands, including saving and printing.
Tofindoutwhatabuttondoes,restyourmousepointeronit.Aboxpopsupshowingthefunction of the
button.
The format bar: The format bar contains buttons that you can use to format the text in your
document. For example, you can choose thefont, color, and alignment of your text.

Theruler:Usetherulertocheckthelayoutandplacementoftextinyourdocument.



The document area:This is where you type your document, make changes to the text, and
apply your formatting.

Typingtext:Whenyou'rereadytogetstarted,typeinthedocumentareaofWordPad.Aflashing
verticallinecalledthecursor indicateswherethenexttextthatyoutypewillappear.Tomove the cursor
within text, click where you want the cursor to appear.

Unlike usinga typewriter, when you type inWordPad you don'thave topress ENTERto starta
newline.WordPad will take care of thatfor you byautomaticallystarting a newline when you
reach the end of the one you're working on. When you want to start a new paragraph, press
ENTER.

Selectingtext
Wheneveryouwanttodosomethingtotextinyourdocument,suchascopyitorformatit,you
needtoselectitfirst.Toselecttext,positionthemousepointertotheleftofwhereyouwantto
beginyourselection.Withthepointerpositioned,clickandholdtheleftmousebuttonwhileyou
dragthepointeroverthetextthatyouwanttoselect.Theselectedtextwillbehighlighted.Once you've
completed your selection, release the mouse button.

Copyingandmovingtext
Ifyouhavetextinonepartofyourdocumentthatyouwanttoappearinanotherpart,thereare two ways
to move the text around without having to retype it: You can copy and paste it to another
location, or you can move it to another location.

When you copy text, it is placed in the Clipboard. You can then paste it in a different location.
The original text is preserved.

Whenyou move text to another location, theoriginal text is not preserved. You might findthis
method useful when you want to rearrange the sentences and paragraphs in your document.

To copytext and paste it in another location

1. Selectthetextthatyouwanttocopy.

2. OntheEditmenu,clickCopy.

3. Movethecursortothelocationwhereyouwanttoinsertthecopiedtext.

4. OntheEditmenu,clickPaste.Tip

• Toquicklycopytextthatyou'veselected,pressCTRL+C.Topasteit,pressCTRL+V.

Insertinganddeletingtext
WordPadmakesiteasytoinsertanddeletetextwhereveryouwant.Toinserttext,clickwhere
youwanttoinsertthetextandthenjuststarttyping.Todeletetext,selectthetextthatyouwant to delete,
and then press DELETE.

Formattingyour document



Formatting refers to the how the text in your document looks as well as how it is arranged.
WordPadletsyoueasilychangetheformattingin yourdocument.Forexample,youcanchoose
frommanydifferentfontsandfontsizes,andyoucanmakeyourtextalmostanycoloryouwant. You can
also easily change how your document is aligned.

Tochangethefont,fontstyle,orfontsize:

1. Selectthetextwhoseformattingyouwanttochange.

2. OntheFormatmenu,clickFont.

3. IntheFontbox,typeorselectthefontyouwanttouse.

4. IntheFontStylebox,typeorselectthefontstyleyouwant.

5. IntheSizebox,typeorselectthesizeyouwanttouse.

Tochange the color

1. Selectthetextwhosecoloryouwanttochange.

2. OntheFormatmenu,clickFont.

3. UnderColor,clickthecolorthatyouwant.

Tochange the alignment

Youcanalignthetextinyourdocumenttoeithertheleftmargin,thecenter,ortherightmargin.

1. Selecttheparagraphwhosealignmentyouwanttochange.

2. OntheFormatmenu,clickParagraph.

3. IntheAlignmentbox,clickthealignmentyouwant.

Savingyourdocument
It's a good idea to save your document periodically while you are working on it so that incase
your computer stops working for some reason, you won't lose any of your work. Saving the
documentwillalsoallowyoutocomebacktoitlaterifyouwanttoworkonitagain.

Tosavethedocument

• OntheFilemenu,clickSave.
Ifyouhaven'tsavedthedocumentyet,you'llbeaskedtoprovideanameforthedocument and
location on your computer to save it to:

1. IntheSaveinbox,clickthelocationwhereyouwanttosavethedocument.

2. IntheFilenamebox,typeanameforyourdocument.

3. ClickSave.



Printingyourdocument
OntheFilemenu,clickPrint.InthePrintdialogbox,usethePageRangeboxandtheNumber of
copies box to specify which pages you want to print as well as how many copies. When
you're done, click Print.

MICROSOFTOFFICE
Microsoft Office is an office suite of desktop applications, servers and services for the
Microsoft Windows and OS X operating systems, introduced by Microsoft on August 1, 1989.
Initiallya marketingtermfora bundled set ofapplications,thefirstversion of Officecontained
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years, Office applications
have grown substantially closer with shared features such as a common spell checker, OLE
data integration and Microsoft Visual Basic for Applications scripting language. Microsoft also
positions Office as a development platform for line-of-business software under the Office
Business Applications brand. Office is reported to now be used by over a billion people
worldwide.

ThecurrentversionsareOffice2013forWindows,releasedonOctober11,2012andOffice
2011forOSX,releasedOctober26,2010.On24October2012,theRTMfinalcodeofOffice 2013
ProfessionalPlushas been releasedtoTechNetandMSDNsubscribersfordownload.On
15November2012,the60-daytrialversionofOffice2013ProfessionalPluswasreleasedfor
download.



MS-WORD
MicrosoftWordisanexampleofaprogramcalleda―wordprocessor.‖Thekeybenefittousing a word
processor is that you can make changes easily, including correcting spelling; adding,
deleting,formatting,andrelocatingtext;andinsertingimages.Onceyoucreateadocument,you
caneffortlesslyprintit (asmanycopiesasyouwant!),saveitforlatermodifications,orsendit to a friend
via e-mail. Microsoft Word is a very powerful word processor—this handout was created using
just a small number of its features!

Microsoft Word is available on both PCs and Macs, so what you learn in class today should be
applicable toanycomputeryouuse.Theprogram maylook slightlydifferent dependingon the
versionandcomputerthatyou‘reusing,butMicrosoftWordwillfunctioninthesamebasicways.
Thereareotherwordprocessorsoutthere,includingOpenOffice.orgWriter,WordPerfect,Apple
Pages,andWordPad.TheyhavemanyfeaturesincommonwithMicrosoftWord,andyoushould feel
free to choose any program you prefer.

OpeningMicrosoft Word
TogetstartedwithMicrosoftWord(sometimescalled―MSWord‖),youwillneedtolocateand
opentheprogramonyourcomputer.Toopentheprogram,pointtoWord‘sicononthedesktop
withyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon‘tseetheMSWord
icononyourdesktop,you‘llhavetoaccesstheprogramfromtheStartMenu.Clickonthebutton in the
bottom left corner to pull up the StartMenu. You should see the MSWord icon here, so click on
itonce with your leftbutton. If you still don‘t see it, click on―All Programs‖ and scroll
throughthelistofprogramsuntilyoufindit.Clickoncewithyourleftbuttontoopentheprogram.
Occasionally,MicrosoftWordwillbeinafoldercalled―MicrosoftOffice‖orsomethingsimilar— this will
make one more step between ―All Programs‖ and
―MicrosoftWord.‖

MSWordwillthenopenablankpage called―Document1.‖
This is an image of the upper-left corner of MSWord. This box features two important pieces
ofinformation:thenameofthefilethatyouarecurrentlyworkingon(inthiscase,―Document
1‖sincewehavenotyetrenamedit)andwhichprogramyouareusing(―Microsoft Word‖).There
should nowbe a blinkingline in the top left corner of the part of the screenthat looks like a
sheet of paper. This means you will be able to type in this space!

MicrosoftWordFeatures



TheTitleBar
This is a close-up viewof theTitle Bar, where file information is located. It shows the nameof
thefile(here,―MicrosoftWord‖)andthenameoftheprogram(―MicrosoftWord‖).Noticethe
threebuttonsontheright side, controllingthe size and closingof the program.
Minimize:Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearin the task
bar
Maximize:Leftclickthisbuttontomakethewindowaslargeasitcanbe—itshouldtakeupyour entire
screen.
Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure
you save your work first!
RestoreDown:
Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.ThetabbedRibbonmenu system
is how you navigate through Word and access various Word commands. If you have used
previous versions of Word, the Ribbon system replaces the traditional menus.

The File Menu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the top
left-handcorner.InMicrosoftOffice2010,thishasbeenreplacedwithatabintheRibboncalled
―File.‖
When you left-click onthis tab, a drop-down menu appears. From this menu, you can perform
the same functions as were found under the Microsoft Office Button menu, such as: Create a
newdocument, open files, save files in a varietyof ways, and print. Quick Access Toolbar
On the top left-hand side of the Title Bar, you will see several little icons above the File menu.
Theseletyouperformcommontasks,suchassavingandundoing,withouthavingtofindthem in a
menu.We‘ll go over the meanings of the icons a little later.



TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that can
changethefont,size,color,alignment,organizationandstyleof thetextinthedocument.
Forexample,the―TimesNewRoman‖IndicatestheFONTofyourtext,the―12‖indicatesthe SIZE of
your text; etc. We will go over how to use all of these options to format your text in a
littlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-clickonthetinydown-arrowin
thebottomrightcornerofthewindow.TherulerisfoundbelowtheRibbon.Therulertellsyou
whereyouareonthepage,alongwiththedimensionsoftheoveralldocument.Justlikeareal piece of
paper, the default setting is 8.5 x 11 inches, and the margins have been incorporated
foryou.SimilartomostoptionsinMSWord,thisisentirelycustomizableandtheusercancreate a
document of any dimensions.

Keyboard Review

In order to use MSWord effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of you;
learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping,aswellaspresent you with
more options within the program. The following is a list of commonly used keys that
havespecialfunctionsinMSWord(keyfunctionscanchangedependingonwhichprogramyou are
using):

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondary
Function.

4. Spacebar:This keyentersa spacebetween wordsorletters.

5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault Indent

distance is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:This keyeithergives you a newline, or executesa command (pressed inMSWord, it

begins a new line).

9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe



Keyboard;somepeoplejustfindthemeasiertouseinthisposition.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocument.

MICROSOFT WORDBASICS

TypingText

Toentertext,typejustasyou wouldif youwereusingatypewriter.Tocapitalizealetter,hold
downtheSHIFTkeywhiletypingtheletter.Or,presstheCAPSLOCKkeyontheleft-handside of your
keyboard. You will have to press the CAPS LOCK key again—once you are done capitalizing—
toremovethelock.YoudonotneedtopressENTERtostartanewline—Microsoft Word
willautomatically wrap yoursentenceat the end of the line.Tomove the cursorfrom its
positionattheendofyoursentencetoanywhereelseonthepage,usethemouseorthearrow
keystomovethecursorwhereyouwantthelettersorspacestobe(leftclickthemousetoplace
thecursor)andthentypewhatyouwanttoadd—thetextwillautomaticallyadjusttoincludeit. Press
ENTER to start a new paragraph (this is sometimes called a ―carriage return‖).

Deleting Text

Whiletypingadocument,sometimesyouwillmakeamistake.Unlikeatypewriter,MSWordcan
deletetextonthescreenandleavenotrace—itisasifyounevertypedonthepageinthefirst
place.Therearetwodifferentbuttonsonthekeyboardthatwillallowyoutoerasetext.Theyare
the―Delete‖key andthe―Backspace‖key (#s1and2onthekeyboardmaponpage.The
―Backspace‖keydeleteswordstotheLEFTofthecursor,andthe―Delete‖keydeleteswords
totheRIGHTofthecursor.

BACKSPACE↔ DELETE
Let‘s assume that the vertical line dissecting the word ―creative‖ in the example above is our
cursor. Pressing the ―Backspace‖ key will erase ―a,‖ ―e,‖ ―r,‖ ―c,‖ and so on, movingLEFT.
The ―Delete‖ key will erase ―t,‖ ―i,‖ ―v,‖ ―e,‖ and so on, moving RIGHT.

Todeleteawholechunkoftextatonce,left-clickwithyourmouseanddragtohighlighta section of

text. Then simply press ―Backspace‖ or ―Delete‖ and all of the highlighted Text will

disappear.

Undoingand Redoing

TheUNDOandREDOfeaturesofMicrosoftWindowsapplicationsaregreattoolstorelyon.The
programwillkeepalistofthelast25commandsthatyouhaveperformed,anditallowsfortaking
―onestep‖backwardsinordertoerasewhatyouhavejustdone.ClickontheUNDObuttonin



the Quick Access Toolbar to go back one step. Click on the REDO button in the Quick Access
Toolbar to go forward one step.

FormattingText

Changingthelookofwhatyou‘vewritteniscalled―formatting.‖Thiscanincludechangingthe
textstyle,size,color,andmore.Thisisasentencethatfeaturesmanydifferentfonts.Thisisa sentence
that features many different sizes. From the Home Tab, the ―B‖ will make your text
BOLD,the―I‖willputitinitalics,andthe―U‖willaddanunderlinetoyourtext.Thesefeatures do not
have to be used independently of each other—in other words, you can bold, underline, and
italicize a single piece of text. The alignment of the text can be altered using the buttons with
the horizontal lines on them. You can align text To the LEFT, To the CENTER and to the
RIGHT.

In order to apply certain stylistic or formatting changes to text, you must first
HIGHLIGHT the text. This is a common procedure in Microsoft Windows applications, and
becauseitissouseful,itisaskillworthpracticing.Youcanalsochangethefontcolorbyclicking on the
appropriate buttons in the

Formatting Toolbar. Experiment and remember—you can always start over with a fresh, new
document, so don‘t worry about making mistakes! If you do, however, there is always the
incredible ―UNDO‖ tool. Cutting, Copying, and Pasting Text in MS Word, you can CUT orCOPY
text from one area of the document and save that text to be PASTED elsewhere (these
commandsarefoundontheHomeTab).WhenyouCUTtext,youactuallydeleteitfromwhere you took
it, as opposed to COPYING it, which makes a copy of your selection.

When you CUT or COPY text, it is stored on the CLIPBOARD. The Clipboard is a tool in MS
Word that stores cuts and copies of your work, to be pasted in other places in the document.
Once your selection is on the CLIPBOARD, you can PASTE it as many times as you want!
CUTTINGaselectionwillplaceitontheclipboard,justincaseyouwanttoPASTEitelsewhere. To CUT a
selection, first highlight it. Then, click on the CUT icon from the Home Tab. The
highlightedtextwilldisappear,asyouhavejustcutitout,buta copyisnowonyourclipboard, and MS
Word is waiting for you to paste it somewhere else.

ToPASTEthiscutselection,placeyourcursorwhere youwanttheselectiontogo.Clickonthe
PASTEiconfromtheHomeTabtoolbar,anditwillpopthetextintoplace,rightwhereyouhave
yourcursor.ToCOPY,simplyfollowthosesamesteps,replacingtheCUTcommandwithCOPY.
TheCOPYcommandwillnotalteryouroriginalselectionatall,asitsimplymakesacopyofthe selection
without changing or deleting it in any way.

DOINGMORE WITHMICROSOFT WORD

InsertingImagesandClipArt

WithMicrosoftWord,youcaninsertpicturesinyourdocumentusingtheInsertTabtoolbar.



You can insert pictures from the ―Clip Art‖ album that comes with the program, or you can
insertpicturesfromafilethatyouhavepreviouslysavedonadiskorelsewhereonthecomputer (e.g.,
the My Pictures folder).Clip Art is a collection of cartoon and computergenerated images that
cover a broad array of commonly needed icons and pictures. These include business, holiday,
nature, entertainment, academic and other themes, along with standard bullets and symbols.

To insert a clip art picture into a Microsoft Word document, you will first need to place your
cursor(left-click)whereyouwishtoinsertyoupictureinyourdocument.Then,fromtheInsert
tabontheRibbon,clickon“ClipArt.”AClipArtsearchboxwillappearontherightsideofyour screen.
From here, you can enter a search word for the picture you would like to find.
Thenclick―Go.‖Thiswillshowalltheoptionsofpicturesyoucaninsert.Whenyouseeapiece
ofclipartthatyoulike,clickonit,anditwillautomaticallyinsertintoyourdocument,intheexact
placewhereyouleftthecursor.Toresizeyourimage,graboneof thecornersoftheimageby left-clicking
and holding—drag it to your desired size and fine-tune the placement. The cursor will change
from a typing icon to a double arrow when it can be used to resize an image.

Dragthecornertowardtheupper-leftcornerofthescreen,andtheimagewillgrow.Dragtoward the
bottom-right, and itwillshrink. You can move the image toanother place in the document
byleft-clickingandholdingonthecenterofit;dragittoitsdesiredlocation.Moreoptions,such
asaligningtheimagewithtext(orspecialeffectslikewrappingtextaroundorthroughanimage) can
befound byclickingon the picture, and then choosingthe PictureToolsTab. You canalso
insertaphotographorotherimagesfromyourfilesusingthissameprocess.OntheInsertTab, click on
Picture and locate the files that you want to include.

ModifyingLine Spacing

Line spacing inWord refers to the amount of space between lines of text. The default inWord
2010is1.15spacing,whichleavesalittlebitmorespacethansingle-spacing,orwhatyouwould
findinanormalbook.Singlespacingisgenerallyeasyfortheeyetoread.Theremaybetimes, however,
when you want to change this spacing. One common option is to doublespace text: Thistext
isdouble-spaced. Double-spacingisespeciallyusefulif someoneelse isproof reading
yourdocument.Itallowsformoreroom towritecommentsonthepage.

Tochange theline spacing:

1. Selecttextyouwanttoformatbyhighlightingit.

2. OntheHomeTab,clickontheLineSpacingbuttonintheParagraphgroup.

3. Choose the spacing you want from the menu that appears. For more options, select Line
Spacing Options. In the dialog box that appears, you can choose other spacing options,
includingspacingbetweenparagraphs.Thiscanbedonebychangingthevaluesinthebefore and
after boxes.



CreatingBulletedand Numbered Lists

Word allows you to create lists within your document that can be organized with bullets or
numbers. Lists are useful for presenting text that wouldn‘t make the most sense in paragraph
form (for example, step-by-step instructions) or for emphasizing key points Bullets are usually
smallcirclesatthe beginningof iteminalist, andnumbersareusedforlists thatarearranged in
sequential order. Here‘s an example of a bulleted list:

• Bananas
• Milk
• Eggs
• IceCream

Tocreatealist:

1. On the Home tab, select eitherthe Bullets orNumberingbuttonsfrom the Paragraph group.
Ifyouwanttochooseaparticularstyleforyourbulletsornumbers,clickonthetrianglenext to the
button and choose a style from the menu that appears.

2. You will see the first bullet or number appear on your document. Type your first line of text
and then hit Enter.

3. Anotherbulletornumberwillappearautomatically.TypeyournextlineoftextandhitEnter.

4. Whenyouhavefinishedyourlist,hitEntertwicetoendthebulletsornumbering.

ChangingViewsandOverall Look
There will be times when you need to create documents that don‘t fit on a standard piece of
paper (8.5‖ by 11‖).

ClickonthePageLayoutTab.

Fromthismenu,youcanalterthemargins,width,height,andorientation(portrait=11‖14long;
landscape=11‖wide)ofthedocument,aswellaschoosefromavarietyoftemplates,different
typesofpaper,anddocumentstylesthatcomewiththeprogram. Tochangetheorientationof your
page, click on the Orientation button.

Click on Landscape from the drop-down box that appears. Your document should now be in
landscape position. If you wish to return to portrait orientation, go through the same steps,
clicking on the Landscape option instead of Portrait. If you would like to change the display of
yourdocumentorzoominandoutwithoutaffectingthewayyourdocumentwillprint,youcan
dothatfromtheViewTab.AnythingyouchangefromtheViewTabwillnotchangethewayyour
document prints out. So if you want your text to be bigger when you print out the document,
make sure to change the size of the font instead of the zoom.

SpellingandGrammar Check



Onebenefitofusingacomputerizedwordprocessorisitsabilitytorecognize,change,andgive advice
about your writing. MS Word has utilities that can check your spelling and grammar
againstamasterdatabase,andcanofferadviceonavarietyofdifferentgrammaticalstyles.MS Word
automaticallyunderlinesanywords that itdoesnotrecognizein red,assumingthatthey
arenotspelledcorrectly,andunderlinesingreenifitdoesnotrecognizethegrammaticalpattern,
assuming that the sentence does not make sense.

For example: In this case, ―jumping‖ should read ―jump‖ and ―laziy‖ should be ―lazy.‖ If
yourightclickontheword,amenuwithpopupwithoptions,including―Ignore‖ifyoudonot want help
on this specific phrase or agree with the suggestion. You can also choose to add
wordstotheMSWordspellingdatabase,ifyouaregoingtousethemoftenanddon‘twantthem to be
flagged as misspelled every time—this is especially useful for names, as MS Word often
interprets these as misspellings. The spelling and grammar tools can be found in the Review
Tab

USINGMICROSOFTWORD

Microsoft Word is an example of a program called a ―word processor.‖ Word processors are
usedtocreateandprinttextdocumentsinmuchthesamewaythatyouwoulduseatypewriter. The key
benefit to using a word processor is that you can make changes easily, including
correctingspelling;adding,deleting,formatting,andrelocatingtext;andinsertingimages.Once you
create a document, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a friend via e-mail. Microsoft Word is a very powerful word
processor-This handout was created using just a small number of its features! Microsoft Word
isavailableonbothPCsandMacs,sowhatyoulearninclasstodayshouldbeapplicabletoany computer
you use. The program may look slightly different depending on the version and
computerthatyou‘reusing,butMicrosoftWordwillfunctioninthesamebasicways.Thereare other
word processors out there, including OpenOffice.org Writer, WordPerfect, Apple Pages, and
WordPad. They have many features in common with Microsoft Word, and you should feel free
to choose any program you prefer.

OpeningMicrosoft Word

TogetstartedwithMicrosoftWord(sometimescalled―MSWord‖),youwillneedtolocateand
opentheprogramonyourcomputer.Toopentheprogram,pointtoWord‘sicononthedesktop
withyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon‘tseetheMSWord
icononyourdesktop,you‘llhavetoaccesstheprogramfromtheStartMenu.Clickonthebutton in the
bottom left corner to pull up the StartMenu. You should see the MSWord icon here, so click on
itonce with your leftbutton. If you still don‘t see it, click on―All Programs‖ and scroll
throughthelistofprogramsuntilyoufindit.Clickoncewithyourleftbuttontoopentheprogram.



Occasionally,MicrosoftWordwillbeinafoldercalled―MicrosoftOffice‖orsomethingsimilar— this will
make one more step between ―All Programs‖ and ―Microsoft Word.‖MS Word will then open
a blank page called ―Document 1.‖This is an image of the upper-left corner of MS
Word.Thisboxfeatures two importantpieces of information:thenameof thefile thatyou are
currentlyworkingon(inthiscase,―Document1‖sincewehavenotyetrenamedit)andwhich program
you are using (―Microsoft Word‖).There should now be a blinking line in the top left cornerof
thepartof thescreenthatlookslikeasheetof paper.Thismeansyouwillbeableto type in this space!

MICROSOFT WORDBASICS

TypingText

Toentertext,typejustasyou wouldif youwereusingatypewriter.Tocapitalizealetter,hold
downtheSHIFTkeywhiletypingtheletter.Or,presstheCAPSLOCKkeyontheleft-handside of your
keyboard. You will have to press the CAPS LOCK key again—once you are done capitalizing—
toremovethelock.YoudonotneedtopressENTERtostartanewline—Microsoft Word
willautomaticallywrap yoursentenceat the end of the line.Tomove the cursorfrom its
positionattheendofyoursentencetoanywhereelseonthepage,usethemouseorthearrow
keystomovethecursorwhereyouwantthelettersorspacestobe(leftclickthemousetoplace
thecursor)andthentypewhatyouwanttoadd—thetextwillautomaticallyadjusttoincludeit. Press
ENTER to start a new paragraph (this is sometimes called a ―carriage return‖).

Deleting Text

Whiletypingadocument,sometimesyouwillmakeamistake.Unlikeatypewriter,MSWordcan
deletetextonthescreenandleavenotrace—itisasifyounevertypedon thepageinthefirst
place.Therearetwodifferentbuttonsonthekeyboardthatwillallowyoutoerasetext.Theyare
the ―Delete‖ key and the ―Backspace‖ key (#s 1 and 2 on the keyboard map on page.

The―Backspace‖keydeleteswordstotheLEFTofthecursor,andthe―Delete‖keydeletes
wordstotheRIGHTofthecursor.

MicrosoftWordFeatures The

Title Bar

This is a close-up viewof the Title Bar, where file information is located. It shows the nameof
thefile(here,―MicrosoftWord‖)andthenameoftheprogram(―MicrosoftWord‖).Noticethe
threebuttonsontheright side, controllingthe size and closingof the program.

Minimize:Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearin the task
bar

Maximize:Leftclickthisbuttontomakethewindowaslargeasitcanbe—itshouldtakeupyour entire
screen.



Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure
you save your work first!

RestoreDown:Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.

The FileMenu

In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the top
left-handcorner.InMicrosoftOffice2010,thishasbeenreplacedwithatabintheRibboncalled
―File.‖ When you left-click on this tab, a drop-down menu appears. From this menu, you can
perform the same functions as were found under the Microsoft Office Button menu, such as:
Create a new document, open existing files, save files in a variety of ways, and print.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that can
changethefont,size,color,alignment, organizationandstyleof thetextinthedocument.
Forexample,the―TimesNewRoman‖indicatestheFONTofyourtext;the―12‖indicatesthe SIZE of
your text; etc. We will go over how to use all of these options to format your text in a
littlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-clickonthetinydown-arrowin the
bottom right cornerof the window.

The Ruler
TherulerisfoundbelowtheRibbon.Therulertellsyouwhereyouareonthepage,alongwith
thedimensionsoftheoveralldocument.Justlikearealpieceofpaper,thedefaultsettingis8.5 x 11
inches, and the margins have been incorporated for you. Similar to most options in MS Word,
this is entirely customizable and the user can create a document of any dimensions.

Keyboard Review

In order to use MSWord effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of you;
learningjustafewcertainkeyswillhelptoimproveyourefficiencyin typing,aswellaspresent you with
more options within the program. The following is a list of commonly used keys that
havespecialfunctionsinMSWord(keyfunctionscanchangedependingonwhichprogramyou are
using)

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.

4. Spacebar:This keyentersa spacebetween wordsorletters.



5. Tab: This key will indent what you type, or move the text to the right. The default indent
distance is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter you type
capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:This keyeithergives you a newline, or executes a command(pressed in MSWord,it
begins a new line).

9. Number Keypad: These are exactly the same as the numbers at the top of the keyboard;
some people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentorpage.

MICROSOFTEXCEL
Microsoft Excel is an example of a program called a ―spreadsheet.‖ Spreadsheets are used to
organize real world data, such as a check register or a rolodex. Data can be numerical or
alphanumeric(involvinglettersornumbers).Thekeybenefittousingaspreadsheetprogramis that
you can make changes easily, including correcting spelling or values, adding, deleting,
formatting, and relocating data. You can also program the spreadsheet to perform certain
functions automatically (such as addition and subtraction), and a spreadsheet can hold almost
limitless amounts of data—a whole filing cabinet‘s worth of information can be included in a
singlespreadsheet.Onceyoucreateaspreadsheet,youcaneffortlesslyprintit(asmanycopies
asyouwant!),saveitforlatermodifications,orsendittoacolleagueviae-mail.MicrosoftExcel is a very
powerful.

OpeningMicrosoftExcel
TogetstartedwithMicrosoftExcel(oftencalled―Excel‖),youwillneedtolocateandopenthe
programonyourcomputer.Toopentheprogram,pointtoExcel‘sicononthedesktopwithyour
mouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon‘tseetheExcelicononyour
desktop,you‘llhavetoaccesstheprogramfromtheStartMenu.Clickonthebuttoninthebottom left
corner to pull up the Start Menu. You may see the Excel icon here, so click on it once with
your left button. If you still don‘t see it, click on ―All Programs‖ and scroll through the list of
programs until you find it. It may also be located in a folder called ―Microsoft Office‖ or
something similar—it will depend on your specific machine. Click once with your left button to
open the program. Excel will then open a blank page called ―Book1.‖

MicrosoftExcelFeatures



The Title Bar
This is a close-up viewof the Title Bar, where file information is located. It shows the nameof
thefile(here,―Book1,‖thedefaulttitle)andthenameoftheprogram(―MicrosoftExcel‖).You will be
able to name your file something new the first time that you save it. Notice the three
buttonson theright sideof theTitle Bar,controllingthe sizeandclosingof theprogram.

TheRibbon Menu System
The tabbed Ribbon menu system is how you navigate through Excel and access various Excel
commands. If you have used previous versions of Excel, the Ribbon system replaces the
traditionalmenus.Atthebottom,leftareaofthespreadsheet,youwillfindworksheettabs.By
default,threeworksheettabsappeareachtimeyoucreateanewworkbook.Onthebottom,right area of
the spreadsheet you will find page view commands, the zoom tool, and the horizontal scrolling
bar.

The FileMenu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the top
left-handcorner.InMicrosoftOffice2010,thishasbeenreplacedwithatabintheRibboncalled
―File.‖When you left-click on this tab, a drop-down menu appears. From this menu, you can
perform the same functions as were found under the Microsoft Office Button menu, such as:
Create a new worksheet, open existing files, save files in a variety of ways, and print.6 Quick
AccessToolbarOnthetopleft-hand sideof theTitle Bar, you willsee several little iconsabove
theFilemenu.Theseletyouperformcommontasks,suchassavingandundoing,withouthaving tofind
themin amenu.We‘llgo overthemeaningsof the iconsa little later.

TheHomeTab



The most commonly used commands in Excel are also the most accessible. Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that can
changethefont,size,color,alignment,organizationandstyleofthetextinthespreadsheetand
individual cells. Forexample,the―Calibri‖ indicatesthe FONT of your text, the―11‖indicates
theSIZEofyourtext;etc.Wewillgooverhowtousealloftheseoptionstoformatyourtextin
alittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-clickonthetinydown-arrow in the
bottom right corner of the window. This tab works the exact same way as the MSWord
FormattingToolbar.Themaindifferenceisthattheformatchangeswillonlyaffecttheselected cell or
cells, all unselected cells remain in the default setting (―Calibri‖ font, size ―11‖).

Equation Editor
The Equation Editor is generally found below the ribbon menu. The left side denotes
whichcellisselected(―C5‖)andtherightsideallowsyoutoinputequationsortextinto the
selected cell.
Therearetwowaystoinputinformationintoacell.Youmayeitherselectanindividualcelland type the
equation or text into the equation editor or type the equation or text directly into the selected
cell. Equations (for example, =SUM(D5+E5)) will automatically be hidden inside the cell and
can only be viewed using the equation editor; the result of the equation will display in
thecell.Ifanywrittentextislongerthanthecellwidth,thenthespreadsheetwillcoverupany
portionlongerthanthecellwidth.Theinformationwillstillbeinthecell,youjustwon‘tbeable to see it at
all times.

Keyboard Review
In order to use Excel effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of you;
learningjust afewcertain keys willhelp to improve yourefficiencyin typingas wellas present
youwithmoreoptionswithintheprogram.Thefollowingisalistofcommonlyusedkeysthatyou may
already be familiar with:
1. Backspace:Thiskeydeleteslettersbackwards.
2. Delete:Thiskeydeleteslettersforward.
3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.
4. Spacebar:This keyentersa spacebetween wordsorletters.
5. Tab: This key willindentwhatyoutype,or movethetexttotheright.Thedefault indent distance is
usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.
7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.
8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand.
9. NumberKeypad: Theseare exactlythesameasthenumbersatthetopofthekeyboard; some
people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentorpage.

Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work inExcel.
Eachpointershapeindicatesadifferentmodeofoperation.Thistableshowsthevariouspointer shapes
you may see while working in Excel.



MICROSOFTEXCEL BASICS

Formatting Cells
Cellsarethesmallrectangularboxesthatmakeupthespreadsheet.Alltheinformationentered
intoanExcelspreadsheetisenteredintocells.Thecellwidthandheightwillusuallyneedtobe adjusted
to view all the information entered into a cell.

To adjust the cell width, move the mouse pointer in between two cell columns in the column
header.Holddowntheleftmousebuttonanddragthemouselefttoshortenthewidthorrightto
expandthewidth.Noticethatallcellswithinthecolumnareautomaticallyadjusted.Adjustthe cell
height using the same method. Move the mouse cursor between two rows, hold down the left
mouse button and move the mouse up to decrease the height and down to increase the
height.Beforeyoubeginenteringdataintoaspreadsheet,youmayalreadyknowthewidthand height
you want your cells to have. In this case, you can adjust all the widths and heights by doing
the following: Select the ―square‖ between Column A and Row 1.

This will select ALL the cells in the spreadsheet. From the ―Home‖ tab of the Ribbon Menu,
within the ―Cells‖ box, click on ―Format,‖ and select Row Height. You will now be asked to
entera numerical value for height. The default value is 15, but you can enter your own height
value (10, 20, 25, etc.).

RepeatthesamestepsforColumnwidth.Fromthe―Home‖taboftheRibbonMenu,withinthe
―Cells‖ box, click on ―Format,‖ and select Column Width. Note that the default value for the
widthis8.43.Enteryourownwidthvalue(5,10,15,20,etc.).

Foranygivencellorselectedcells,youcanalsoformatthewayyourdataisrepresentedwithin the cell(s).
Select a single cell or multiple cells.
Again, from the ―Home‖ tab of the Ribbon Menu, within the ―Cells‖ box, click on Format.‖
Select―FormatCells.‖Theformatwindowwillnowappear,givingyouawidevarietyofoptions on how
to format your cell.

Number –Thisallowsyoutochoosehowtorepresentthenumbersthatareenteredintoacell (number,
currency, time, etc.).
Alignment–Thisdetermineshowthedatawillbealignedwithinthecell(left-side,centered,or right-
side).
Font–Selectthetypeoffonttobeusedwithinthecells.
Border–Thisoptionletsyouchoosewhattypeofborder,ifany,youwouldlikearoundthecells or some of
the cells.
Fill –Thisallowsyoutochangethebackgroundcolorofthecell.
Protection –Thisoptionallowsyouto―lock‖cellinformationsothatotheruserscannotmake changes.

TypinginCells
Clickonacelltobegintypinginit.Itisthateasy!Whenyouarefinishedtypinginthecell,press
theEnterkeyandyouwillbetakentothenextcelldown.Youcanthenbegintypinginthatcell.
Youcaneasilynavigatearoundthecellsusingyourarrowkeys.KeepinmindthattheFormatting



toolbar in Microsoft Excel 2010 is exactly the same as the one used for Microsoft Word 2010.
The biggest difference between the two programs is that, in Excel, the format is set for each
individual cell.

So if you change the font and applied the bold option in cell C5, then this format will only be
appliedtocellC5.Allremainingcellswillremainindefaultmodeuntiltheyhavebeenchanged.
Sometimes you may only wish to adjust the format of one particular cell. In this case, simply
selectthecellbyclickingthemouseonitandmakeanynecessaryadjustmentstothefont,size, style, and
alignment. Those changes will not carry over when you begin typing in a new cell. Other times,
you may wish to adjust the text format of a group of cells, entire rows, or entire columns.

In Excel, you can choose groups of cells in rectangular units—allthecells
you select must form a rectangle of some kind. To select a group of cells, begin by clicking on
thecellthatwouldbeintheupper-lefthandcornerofyourrectangle.HolddowntheShiftkeyon
yourkeyboardandusethearrows(←,→,↑,↓)onthekeyboardtoexpandtheselectionofcells, or click
and drag your mouse. Once the group of cells has been selected, you can make
adjustmentstothefont,size,style,andalignmentandtheywillbeappliedtoallselectedcells.

To select an entire row, click on the Row Number with your mouse—note how the entire row
becomeshighlighted.Allformattingchangeswillnowbeappliedtothewholerow.Toselectan entire
column, click on the Column Number with your mouse—again, the entire column will become
highlighted. All formatting changes will be applied to the whole column.

InsertingRowsand Columns.
When you are workingon a spreadsheet, you mayrealize that you left out a roworcolumnof
dataandneedtoadditin.Toinsertarow,clickontherowbelowwhereyouwantyournewrow
tobe(remembertoclickontherownumbertohighlighttheentirerow).Fromthe―Home‖tab, within
the ―Cells‖ box, click ―Insert.‖ Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automaticallyadjusted.Toinserta column, click on the column tothe right of where youwant
yournewcolumntobe(remembertoclickonthecolumnlettertohighlighttheentirecolumn). From
the ―Home‖ tab, within the ―Cells‖ box, click ―Insert.‖ Select ―Insert sheet Columns.‖ A
new column will automatically be inserted and the column letters automatically adjusted.

SortingData
Onceyouhavecreatedyourspreadsheetandenteredinsomedata,youmaywanttoorganize the data
in a certain way. This could be alphabetically, numerically, or another way.
Let‘slookatthefollowingspreadsheetasanexample.Thisinformationcanbesortedbycheck number,
date, alphabetically by description, or using any of the other columns.

First, select all the cells that represent the data to be sorted, including the headerdescriptions
(Check No., Date, Description, etc.). Then, select the first cell in Row 1 (Check No.) Click and
dragto select allthe cellsthatyou want to sort.Usingthemouse, select Sort& Filterfromthe Editing
panel. Select Custom Sort…



Select the column you wish to sort by. Do you want to sort by alphabetical order, reverse
alphabeticalorder,date,oramount?Whenyoupress―OK,‖yourspreadsheetwillbesortedin the
order that you specified.

AutoSumandExcelEquations
OneofthemostpowerfulfeaturesofExcelisitsabilitytoperformbasicmathfunctionsondata. Excel can
add, subtract, multiply, divide, find the average, and perform general counting
functionsonthenumericaldatathatyouenter.Toenablethisfeature,highlightallofthecellsin a column,
plus one additional empty cell in which to display the result.

SelecttheAutoSumiconfromtheribbonmenu:
Ifyouclickdirectlyonthe∑,Excelwillautomaticallyaddupthenumbersyouhaveselected.If
youclickonthelittledropdownarrownexttoit(▼),youwillgetthefullchoiceofmathematical
functions.Ifyoudouble-clickonthecellinwhichtheanswerappears,youwillseeanequation that looks
something like this (you will also see thisequation in the Equation Editor): Let‘s break down
what exactly the equation means:
=indicatesthatyouarestartinganequationinthiscell.
SUMtellsthefunctiontobeperformed.Inthiscase,allthecellswillbeaddedtogether.
( )Theparentheses containthecells that thefunction will be performedon.
D2Thisisthefirstcelltobeincludedintheadditionformula.
D8Thisisthelastcelltobeincludedintheadditionformulaindicatesthatallcellsbetweenthe first and the
last should be included in the formula.
Thespreadsheetwilloften―select‖thecellsthatitthinksyouwishtoinclude.Butyoucan manually
change the cell range by typing into the Equation Editor. When you are ready to execute the
formula, just press the ―Enter‖ key. Other mathematical functions you can perform from the
AutoSum button include:
Average – This function will calculate the average of the selected cells.
CountNumbers–Thisfunctionsimplycountsthenumberof cellsselected. Max –
This function will return the highest value of the selected cells.
Min–Thisfunctionwillreturnthelowestvalueoftheselectedcells.
*Remember* Excel equations are similar to programming languages, so have some patience
and if at first you don‘t succeed, try again. Even Excel professionals create incorrect formulas
on their first try.
Onceyougetanequationtowork,youwilltechnicallybeacomputerprogrammer!
Creating Charts andGraphs:
InExcel,therearealsowaystorepresentyourdatainchartorgraphicalforms.
Tocreateachartorgraph,selecttheInserttabfromtheRibbonMenubar.Inthemiddleof this new
menu, you will see a ―Charts‖ box.
1. Select the range of data to be represented in the chart or graph. Click on your spreadsheet
andselectthedatatoberepresentedusingthesamemethodthatyouusedtoselectdatainthe
sortingexercise.Forthisexample,wewanttoseeavisualcomparisonofhowmuchmoneywe
spentoneachiteminthelist.Selectrows1through8inrowsB,C,andD.2.Selectthetypeof
chartorgraphyouwishtocreate(forourexample,we‘llchooseabargraph).3.Onceyouhave
createdyourgraph,youcannow―customize‖ itbygivingitatitleandlabelingdifferentparts.
Youcanalsomakecertaindesigndecisionsregardingtheappearanceofyourgraphorchartby choosing
the different elements under the Design tab that appears on the Ribbon Menu bar.



4.Finally,you willneedtodecideif yourchartshouldbepastedontotheexistingspreadsheet
orifitshouldbepastedontoabrandnewsheet.OntheveryrightsideoftheRibbonMenubar, select Move
Chart. Once the chart or graph has been created and you realize a mistake has
beenmadeoritdidnotturnoutthewayyouwanteditto,simplyclickonthechartorgraphand hit the
Backspace key on your keyboard to delete it from your spreadsheet. Don‘t be afraid to go back
and try again!

Multiple Sheets

Sometimes you mayfind ituseful to have multiple spreadsheets for related data. For example,
personal finances are usually tracked on a monthly calendar and it‘s generallygood idea to
keep records of the past transactions. Excel can create multiple spreadsheets attached to the
same Excel file, one for each month. Tabs for the different sheets are located in the lower-left
cornerofthespreadsheet.Thespreadsheetthatiscurrentlybeingworkedonisonthetoptab.
Toaccessanotherspreadsheet,selecttheappropriatetab,suchasSheet2.Thedefaultnames for the
sheets are usually Sheet1, Sheet2, and Sheet3. To rename a sheet or to create a new sheet,
simply move the mouse pointer over the sheet name and right-click. Select ―Rename‖ to
rename the sheet or select ―Insert‖ to create a new sheet.

Youcantransfercellinformationbetweentwoormoresheetsbycreatingasimpleformula.For
example,mostpeoplewhokeeptrackoftheirpersonalfinancesdon‘tbegineverymonthwitha balance
of $0. Instead, the balance at the beginningof the month is transferred overfrom the previous
month. So if you have a March 2012 finance spreadsheet and an April 2012 finance
spreadsheet, you can select a cell in the April 2012 sheet and write in the formula =„March
2012‟! D11
Theequalssign(=)tellsExcelthatthevalueforthiscellistobederivedfromsomewhereinthe
spreadsheet (such as a formula or another cell location).
‗Sheetname‘tellsExcelwhatsheettorefertowhenitretrievesthevalue.Thesinglequotation
marks(‗‗)areimportant.!D11tellsExcelthatitistocopythevaluethatislocatedincellD11 (or whatever
cells you wish to copy the value from).
Ifyouwanttotransfercellinformationfromonecelltoanotheronthesamesheet,youcanuse the exact
same formula; just exclude ‗Sheet name.‘

DOINGMOREWITHMICROSOFTEXCEL

Cutting,Copying,andPastingData
Whenyouaretypinginyourspreadsheet,itcanbeveryhelpfultocutorcopyinformationfrom
onecellandpasteitintoanother.Thiscanhelpreducetheamountoftypingyouhavetodo,as well as
limit the number of typographical errors. Cutting, copying, and pasting the contents of cells in
Excel is very similar to the way you do it inMicrosoftWord.
ThesecommandsareallaccessiblefromtheHometabontheRibbonMenubar.
To CUT the contents of a cell, click on the cell to select it, then click on the Cut button on the
Hometab.Youwillseetheborderofthecellturnintolittle―marchingants.‖Thecontentsare now on
the Clipboard, ready for you to paste them somewhere else.



To PASTE the cut selection somewhere else, click on the cellwhere you want the selectionto
go. Then click on thePaste button on the Home tab.The selection will now appear in the new
cell and be removed from the original cell.

To COPY the contents of a cell, simply follow the directions above but replace the CUT
commandwithCOPY.Thiswillleavethecontentsoftheoriginalcellinplaceandmakeanexact copy of
them in another cell.

FillingDataacrossColumnsand Rows
Anotherwaytocopytextfromonecelltoanotheristodragitor―fill‖itacrossarangeofcells
(aroworacolumn).Thisisagreatmethodifyouwantallthetext(ornumbers)incolumnor
rowtobethesame.Forexample,ifyouhaveaspreadsheetforyouryearlybudgetwithacolumn
forrent,youcouldusethismethodtofillinallthecellsintherentcolumnwiththesamenumber without
re-typing.

Tofillthecontentsofcellsinacolumn:
1. Clickonthecellwiththeinformationyouwanttocopytotheothercells.
2. Hoveryourmouseoverthelittle square(called a―fillhandle‖)inthe bottomright cornerof the
highlighted cell border. Your mouse will turn into a cross.

3. Click on the fill handle and drag your mouse (while still holding the button down) down the
columnuntilyou‘vehighlightedallthecellswhereyouwantthetexttogo.

4. Letgoofthemousebutton.Thetextwillnowappearinallthecellsyouhighlighted.
5. You can follow these same steps to fill the contents of a row rather than a column—simply
drag your mouse across the row instead of down the column.

Youcanalsousethistechniquetocopyformulasacrosscolumnsandrowsinthespreadsheet.

CLOSINGMICROSOFTEXCEL

SavingSpreadsheets

Whenyoufinishyourspreadsheetandwanttoleavethecomputer,itisimportanttosaveyour work,
even if you are printing a hard copy. To save your work in Excel, it is essential to know WHAT
you are trying to save and WHERE you are trying to save it.
Click on the File Tab, then click “Save As” to get started. You can change the filename that
Excelhaschosenjustbytypinganewoneinthe―Filename‖boxatthebottomofthewindow
thatappears.The MyDocumentsfolderon your computer‘s harddrive is a good place tostore your
documents. A blank CD or a USB jump drive are great portable storage options and can
contain aLOTofdata.Excelwillautomaticallysave yourdocumentwith the suffix―.xlsx‖–this
issimplyatagthatletsExcelknowthatyourworkisspecifictothisprogramandwhatversionit
isin.Youdonothavetotypeit–justhighlightwhatisthere(defaultis―Book1‖)andwriteanew file name.
You mayalso chose to save itin an olderformat sothat itcan beopened with older versions of
Excel. After the first save, you can just click ―Save‖ to preserve your work.

However, it is important to note that every following command of SAVE will overwrite your
originalfile,creatingthemostup-to-dateversion.Ifyouwouldliketokeepsavingdifferent



versions of your worksheet, be sure to use the ―Save As‖ function each time you save, using
a slightly different name for each version.

Printing Spreadsheets
ToprintyourExceldocument,clickontheFileTab,thenclick―Print‖fromtheleft-sidecolumn. A Print
Preview and printing options will appear in your Excel window.
Clickthelarge―Print‖buttontosendyourworksheettotheprinter.Youcanchangethenumber
ofcopiesyouwouldliketoprint,changethepaperorientation,choosewhichprinteryouwantto use,
and more.

Finding More Help
You can get help with Excel by clicking on the Question Mark symbol in the upper-right hand
corner of the main menu bar or by pressing the ―F1‖ button. This will take you to help from
Office.com, Microsoft‘s help website. There are also many other resources and tutorials
available online. Youmight try a Google search with the words ―Excel 2010‖ and thefunction
you are trying to perform. Ask your instructor for help finding these resources if you have any
trouble.

Closing the Program
Click on the File Tab, then
click ―Exit.‖OR
ClickontheXinthetoprightcorneroftheExcelscreen.

MICROSOFTPOWERPOINT
Microsoft PowerPoint is a professional presentation program that allows the user to create
"presentation slides" that can bedisplayed on the computerscreenorthrough a projectorthat is
plugged in to the computer. A PowerPoint presentation is a good way to convey pieces of
information, usually in the form of an outline, to a large audience. Generally, PowerPoint
presentations are appealing to users because they are easy to create and edit and generally
small enough to fit onto a CD or a USB Jump Drive. Therefore, a user does not have to carry
around any slides or a slide project, and, if necessary, can make last-minute changes to the
presentation.



MicrosoftPowerPointComponents:

Before you get started with Microsoft PowerPoint (commonly referred to as PowerPoint), you
willneedtolocateandopenitonthecomputer.Itmaybeonyourdesktop.
Onthecomputerdesktop:
1. Double-clickontheMSPowerPointicon
IftheMSPowerPointiconisnotonthedesktop,gototheStartmenu:
1. Click ►Start►Programs►MicrosoftPowerPoint*
MSPowerPointwillopenablankpagecalled"Presentation1."

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Noticethedefaulttitle
"Presentation1." You will get a chance to rename your presentation slides the first time you
choose to save it.

TheMenu Bar
The Menu Bar is a common sight in almost all Microsoft Windows programs. It features text
basedmenus,onwhichvirtuallyeveryoptionavailabletotheuserintheentireprogramislisted. Each
menu expands when clicked (with the left mouse button), offering many options categorized
by specific tasks.

Standard Toolbar
Toolbarsprovide"shortcuts"tocommandsalsofoundintheMenuBar.Toolbarsareusually
locatedjustbelowtheMenuBarandexisttoofferanotherwaytoperformthesametask.The
mostcommonlyusedcommandsinMSPowerPointarealsothemostaccessible.Someofthese
commands are:
New|Open|Save|Print |Preview| Spell-check|Copy|Paste|Undo| Insert



Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization,andstyleofthetextinthepresentationslides.Forexample,(startingfromtheleft side of
the Toolbar) the "Arial" indicates the FONT of your text; the "32" indicates the SIZE of
yourtext;andsoon.ThistoolbarworkstheexactsamewayastheMSWordFormattingToolbar. The
main difference is that the format changes will only affect the text box in which you are
currently working.
Allothertextboxeswill remaininthedefaultsetting("Arial"font,size"32").Design/NewSlide Icons
additional shortcut icons appear on the MS PowerPoint toolbar: the Design icon and the New
Slideicon.Bothcommandsarefrequently used, andit isgoodtobefamiliarwiththeir location on the
toolbar.

The Design icon is a shortcut to the slide design page. Here you will be able
tocreateandedittheappearanceofyourslide(s).TheNewSlideiconautomaticallyaddsanew,
blankslideforyou toworkon. You can keep trackof the slidesyou have alreadyworked on in
theSlideOutlineboxontheleft-handsideofthescreen.Youcanaccessaslideatanytimeby clicking on it
with your mouse through this screen.

SIMPLETASKSINMICROSOFTPOWERPOINT
Text Boxes:
Text Boxes are "designated" areas that allow you to type words, sentences, and bullet points
intotheslide.Youcanadjustthesizeandplacementofthetextboxwithinanygivenslide.Itis also
possible to have multiple text boxes per slide.

WhenyoufirstopenMSPowerPoint,therewillautomaticallybetwotextboxesontheslide:

"Click to add title" and "Click to add subtitle." These text boxes already have a preset format
appliedtothem.The"title"boxhasafontsizeof"44"whilethe"subtitle"boxhasafontsizeof
"32."Youcanchangethetextformatofanyboxatanytimebyadjustingtheformatsettingson
theFormattingToolbar.Toadjustthesizeofthetextbox,firstclickonthetextbox.Noticethe change in
border.Once you have clicked ona text box, the borderof the boxbecomes thicker
andlittlecirclesappearonthecornersandatthemidpointsofthebox.Movethemousepointer
overanyoneofthecircles.Noticethatthemousepointerwillchangetoeither↔or↕.Clickand
holddowntheleftmousebutton.Toadjusttheheight,movethemouseupordown;toadjust
thewidth,movethemouseleftorright.Notethatthecornercirclescanadjustbothheightand
width,whilethemid-pointcirclescanonlyadjusteitherheightor width.

Tomovethetextboxtoadifferentlocationontheslide,moveyourmousepointeroveranypart
ofthethick,grayboxoutline.Noticethechangeinyourmousepointer(itwilllooksomethinglike
a"plus"sign(+)witharrows).Clickandholddowntheleftbuttononyourmouse.Youcannow drag the
text box to any position on the slide by simply moving your mouse. To write in a text box,
simply click inside the box with your mouse. When a cursor is flashing, you are ready to type.

Slide Design:



One of the more popular features of MS PowerPoint is that it gives the use a wide variety of
designchoices.Atsomepoint,youmaywishtochangethedesignandcolorofthebackground
ofyourslides.Todoso,simplyclickontheDesignicon.Ontheright-handsideofyourscreen, the "Slide
Design" pane will appear. Here, you are given three design options to apply to your slides.

DesignTemplates:Hereisalistofover20templatesthatyoucanchoosefromtoapplytothe
backgroundofyourslides.Foreachtemplate,youhavetheoptionofapplyingthedesigntoall slides or
to only the selected slide. You can view these options by clicking on the arrow on the right
side of the template. If you are connected to the Internet, you can also choose to view
hundredsofadditionaltemplatesbychoosing"DesignTemplatesonMicrosoftOfficeOnline"on the
bottom of the template screen.

Color Schemes: This option gives you a variety of color schemes to choose from to apply to
your selected design template.

Animation Schemes:Thisoptionwillallow youto selectdifferenttypesofanimationthatcan be
applied to either all the slides or selectedslides. The animation schemes are different ways the
slides are "introduced" to your audience, such as "faded wipe" or "pinwheel."

Designingyour ownbackground:

Sometimesyoumaywishtodesignyourownbackground.

To do this, select Format ► Background… from the Menu Bar. Select the Color Bar on the
bottom of the Background window and choose the appropriate color and or/effects that you
desire. There is no right or wrong way to design your own background, so if you choose this
option, have some patience and don't be afraid to experiment.

Slide Layout:

The default in PowerPoint for each new slide is to have a Title text box and a Text box. As
discussedearlier,youdohavetheoptionofrearrangingthetextboxestofitanylayoutyouhave
inmind.However,sometimesitwillbeeasiersimplytoselectalayoutthatfitsyourneedsrather than
reformatting the default layout for each slide. To choose a slide layout, select Format ►
SlideLayoutfromtheMenuBar.Ontheright-handsideofyourscreen,the"SlideLayout"pane
willappear.From here, you have the option of applyinga slide layout eitherto a selectedslide
ortoanewslidethathasyettobeinserted.Youcanviewtheseoptionsbyclickingonthearrow on the
right side of the template.

Notethefourdifferenttypesoflayout categories.

TextLayout: Theseoptionsareforchoosingalayoutinwhichyouareonlyorganizingdifferent text
boxes. There is no room for pictures, charts, or graphs.



ContentLayout: Theseoptionsareforchoosingalayoutthatwillonlycontainpictures,charts, or
graphs. There is no room for text boxes.

TextandContentLayout:Theseoptionshaveroomforbothtextboxesandpictures,charts,or graphs.

OtherLayouts:Theselayoutsaredesignedforothermediacontentsuchasvideoclipsoraudio tracks.

Inserting a Picture:

InsertingapictureintoMSPowerPointisverysimilartoinsertingapictureintoMSWord.

1. Selecttheslidethatyouwishtoaddapictureto.

2. FromtheMenuBar,selectInsert►Picture►FromFile(orClip Art).

3. Choosethepictureyouwishtoinsertandselect"Insert."

*Note*:Thepicturewillbeinsertedinitsoriginalsize,soyouwillprobablyhavetore-sizeit.You can re-
size a picture the same way you re-sized a text box. Click on the picture and note the circles at
the corners and at the midpoints of the length and width. Move your mouse pointer over the
circles, left-click the mouse and hold the button down. Move the mouse vertically or
horizontally to re-size.

Rotating a picture: ItispossibletorotatepicturesinMSPowerPoint.Onceapicturehasbeen inserted
onto a slide and you have clicked on the picture so it is "outlined," notice the green circle
above the center of the picture.

Movethemousepointeroverthegreencircleandleft-clickandholdthebuttondown.Nowmove
themouseeitherclockwiseorcounter-clockwiseandthepicturewillrotateinthesamedirection.

Inserting aGraph or Table:
TherearetwowaystoinsertagraphortableintoaPowerPointslide.

1. Thegraphortablemayalreadyexistinanotherdocumentorfile.Ifthisisthecase,thenyou can simply

insert the graph or table as you would a picture. Follow the instructions under Inserting a
Picture.

Or you could Cut and Paste a graph or chart from another document or file into your slide
presentation.

2. MSPowerPointcan creategraphsortablesdirectlyin theslide.FromtheMenu Bar, select

Insert►Chart(orTable).



FortheChartoption,PowerPointwillpresentaverysimplebargraph.

Youwillneedtogoinandedittheinformationinthebargraphtoconformtotheinformationyou
wishtorepresentinachart.FromtheDatasheet,youcanenterintheappropriatevaluesforthe columns
and re-name the entities.

TheTableoptionwillpresentyouwiththefollowingwindow:

Selecttheappropriatenumberofrowsandcolumnsyouwishtohaveinyourtable.Click
"OK"toinsertthetable.Oncethetablehasbeeninsertedyouwillbeabletoputinformationintothe table
cells.

Slide Management:

Onceyouhavecompletedaslide,youcancreateanewslidebyclickingontheNewSlideicon. Notice that
your previous slides still appear on the left-side frame. You can still access your previous slides
by simply clicking on them from this location.

Once all your slides have been completed, you can present your slides in a "slideshow." From
theMenuBarselectSlideShow►ViewShow.Noticethattheslidetakesoverourentirescreen. To
navigate through the slides, use the arrow keys on your keyboard (←, → or ↑, ↓). You can
alsonavigatethroughyourslidesbyclickingontheleftorrightarrowsinthelowerleftcornerof your slide.
To end your slide show, click on the square box on the lower left side of your slide
show(thisisdifficulttoseeatfirstbecauseitisdesignedtoblendintoyouslideshowsoitwon't be
noticeable to your audience). Select End Show from the pop-up window.

CLOSINGMICROSOFTPOWERPOINTSaving

SlideShows:

Whenyoucometoastoppingpointandwanttoleavethecomputer,itisimportanttosaveyour work
(even if you are printing a hard copy — saving should be a reflex). To save your work in MS
PowerPoint, it is essential to knowWHAT you are trying to save as well asWHERE you are
trying to save it.

Click►File►Save from the MenuBartogetstarted.

You can change the filename that PowerPoint has chosen just by typing a new one in the File
name box at the bottom of the windowthat appears.

MS PowerPoint will automatically save your document with the suffix ―.ppt‖ – this is simply a
tagthatletsPowerPointknowthatyourworkisspecifictothisprogram.Youdonothavetotype it–
justhighlightwhatisthere(defaultis―Presentation1‖)andwriteanewfilename.TheMy Documents
folder on your computer‘s hard drive is a good place to store your documents. A blank CD
(compact disc) or a USB Jump Drive are great portable storage devices and can
containaLOTofdata.ItisimportanttonotethateveryconsequentcommandofSAVEwill



overwriteyouroriginalfile,creatingthemostup-to-dateversion.Ifyouwanttosaveanychanges to your
PowerPoint slides without destroying the original one:

In the Menu Bar, click ►File ►Save As from the menu bar and give your document a new
filename(uniquefromtheoriginal).TobringasaveddocumentbackuponthescreenfromMS
PowerPoint:

Click ►File ►Open from the Menu Bar. Locate where the file is located (which folder, that is)
and click on the filename of the document you want.

Click ►Open.

PrintingSlides:

Toprint your MS PowerPointslides:

Click►File►PrintfromtheMenuBarandaPrintwindowwillpopuponthescreen. Click ►OK

for your document to start printing.

As with allcommands in MS PowerPoint, you can make changes alongthe way. From thePrint
menu,youcanalterhowmanycopieswillbemade,inwhatorderthepageswillbe,andmuch
more.OtherusefultoolsarethePrintPreviewfunctionfoundalongsidethePrintcommandand the

PageSetup function.PrintPreviewwillallowyoutolookoveranexactcopyofwhatwillcome outof
theprinter before actuallyexecutingthe print command.

Closing the Program:

Whenyouarefinished,
Click►File►Exitfromthemenubar OR

ClickontheXinthetoprightcornerofthecomputerscreen.



INTERNET
The internet in simple terms is a network of the interlinked computer networking worldwide,
whichisaccessibletothegeneralpublic.Theseinterconnectedcomputersworkbytransmitting
datathroughaspecialtypeofpacketswitchingwhichisknownastheIPortheinternetprotocol.

Internetissuchahugenetworkofseveraldifferentinterlinkednetworksrelatingtothebusiness,
government,academic,andevensmallerdomesticnetworks,thereforeinternetisknownasthe
network of all the other networks. These networks enable the internet to be used for various
importantfunctionswhichincludetheseveralmeansofcommunicationslikethefiletransfer,the online
chat and even the sharing of the documents and web sites on the WWW, or the World Wide
Web.

It is always mistaken said that the internet and theWorldWideWeb are both the same terms,
oraresynonymous.Actuallythereisaverysignificantdifferencebetweenthetwowhichhasto
becleartounderstandboththeterms.TheinternetandWorldWideWebareboththenetworks
yet;theinternetisthenetworkoftheseveraldifferentcomputerswhichareconnectedthrough
thelinkageoftheaccessorieslikethecopperwires,thefiberopticsandeventhelatestwireless
connections. However, the World Wide Web consists of the interlinked collection of the
information and documents which are taken as the resource by the general public. These are
then linked by the website URLs and the hyperlinks. Therefore World Wide Web is one of the
servicesofferedbythewholecomplicatedandhugenetworkoftheinternet.TheuseofIPinthe
Internetistheintegralpartofthenetwork,astheyprovidetheservicesoftheinternet,through
differentlayersorganizationthroughtheIPdatapackets.Thereareotherprotocolsthatarethe sub-
classes of the IP itself, like the TCP, and the HTTP.

By the turn of the century, information, including access to the Internet, will be the basis for
personal, economic, and political advancement. The popular name for the Internet is the
informationsuperhighway.Whetheryouwanttofindthelatestfinancial news,browsethrough



library catalogs, exchange information with colleagues, or join in a lively political debate, the
Internet is the tool that will take you beyond telephones, faxes, and isolated computers to a
burgeoning networked information frontier.
The Internet supplements the traditional tools you use to gather information, Data Graphics,
Newsandcorrespondwithotherpeople.Usedskillfully,theInternetshrinkstheworldandbrings
information, expertise, and knowledge on nearly every subject imaginable straight to your
computer.

WhatistheInternet?

The Internet links are computer networks all over the world so that users can share resources
and communicate with each other. Some computers have direct access to all the facilities on
theInternetsuchastheuniversities.Andothercomputers,exampleprivately-ownedones,have
indirect links through a commercial service provider, who offers some or all of the Internet
facilities. In order to be connected to Internet, you must go through service suppliers. Many
optionsareofferedwithmonthlyrates.Dependingontheoptionchosen,accesstimemay

vary.
TheInternetiswhatwecallaMetanetwork,thatis,anetworkofnetworksthatspanstheglobe. It's
impossibletogivean exact count ofthe number ofnetworks or users that comprisethe
Internet,butitiseasilyinthethousandsandmillionsrespectively.TheInternetemploysasetof
standardizedprotocolswhichallowforthesharingofresourcesamongdifferentkindsof computers that
communicate with each other on the network. These standards, sometimes
referredtoastheInternetProtocolSuite,aretherulesthatdevelopersadheretowhencreating new
functions for the Internet.
TheInternetisalsowhatwecalladistributedsystem;therearenocentralarchives.Technically,
noonerunstheInternet.Rather,theInternetismadeupofthousandsofsmallernetworks.The Internet
thrives and develops as its many users find new ways to create, display and retrieve
theinformationthatconstitutestheInternet.

Who OwnstheInternet?
NooneactuallyownstheInternet,andnosinglepersonororganizationcontrolstheInternetin its
entirety. The Internet is more of a concept than an actual tangible entity, and it relies on a
physical infrastructure that connects networks to other networks.

Is WebandInternetthe Same?
The Internet is not synonymous with World Wide Web. The Internet is a massive network of
networks, a networking infrastructure. It connects millions of computers together globally,
forminganetworkinwhichanycomputercancommunicatewithanyothercomputeraslongas they are
both connected to the Internet. The World Wide Web, or simply Web, is a way of
accessinginformationoverthemediumoftheInternet.Itisaninformation-sharingmodelthatis built
on top of the Internet.

WEBBROWSER:
Awebbrowser(commonlyreferredtoasabrowser)isasoftwareapplicationforretrieving, presenting,
and traversing information resources on the World Wide Web. An information resource is
identified by a Uniform Resource Identifier (URI/URL) and may be a web page,

http://www.webopedia.com/DidYouKnow/Internet/2002/WhoOwnstheInternet.asp
http://www.webopedia.com/TERM/W/World_Wide_Web.html
https://en.wikipedia.org/wiki/Software_application
https://en.wikipedia.org/wiki/World_Wide_Web
https://en.wikipedia.org/wiki/Uniform_Resource_Identifier
https://en.wikipedia.org/wiki/Web_page


image,videoorotherpieceofcontent. Hyperlinks presentinresourcesenableuserseasilyto navigate
their browsers to related resources.

Althoughbrowsersareprimarilyintendedto usetheWorldWideWeb,theycanalsobeusedto access
information provided by web servers in private networks or files in file systems.

Usesof Internet

Internetistodayoneofthemostimportantpartofourdailylife.Therearelargenumbersof
thingsthatcanbedoneusingtheinternetandsoitisveryimportant.Youcansaythatwiththe progress in
the internetwe are progressing in everysphere of life asit not onlymakes our tasks easier but
also saves a lot of time. Today internet is used for different purposes depending upon the
requirement. Here in thisveryarticle we have mentioned then ten best uses of the internet.
Here goes the list.

1) Email:

By using internet now we can communicate in a fraction of seconds with a person who is
sittingintheotherpartoftheworld.Todayforbettercommunication,wecanavailthefacilities of
Email.Wecan chatforhourswith ourloved ones.Thereareplentymessengerservices and email
services offering this service for free. With help of such services, it has become very easy to
establish a kind of global friendship where you can share your thoughts, can explore other
cultures of different ethnicity.

2) Information:

Thebiggestadvantagethatinternetofferingisinformation.TheinternetandtheWorldWide Web has
made it easy for anyone to access information and it can be of any type, as the
internetisfloodedwithinformation.TheinternetandtheWorldWideWebhavemadeiteasy for
anyonetoaccess information and it canbe of anytype. Anykindof informationonany topic is
available on the Internet.

https://en.wikipedia.org/wiki/Hyperlinks
https://en.wikipedia.org/wiki/Browse
https://en.wikipedia.org/wiki/Web_servers
https://en.wikipedia.org/wiki/Private_networks
https://en.wikipedia.org/wiki/File_systems


3) Business:

World trade hasseen a bigboom with the help of the internet, as it has become easierfor
buyers and sellers to communicate and also to advertise their sites. Now a day's most of the
people are using online classified sites to buy or sell or advertising their products or services.
Classifiedsitessavealotofmoneyandtimesothis ischosenasmedium bymostofpeopleto advertise
their products. We have many classified sites on the web like craigslist, Adsglobe.com, Kijiji etc.

4) SocialNetworking:

Todaysocialnetworkingsiteshavebecomeanimportantpartoftheonlinecommunity.
Almost all users are members use it for personal and business purposes. It's an awesome
placetonetworkwithmanyentrepreneurswhocomeheretobeginbuildingtheirownpersonal and
business brand.

5) Shopping:

Intodaysbusylifemostofusareinterestedtoshoponline.Nowaday'salmostanythingcan
beboughtwiththeuseoftheinternet.IncountrieslikeUSmostofconsumersprefertoshop
fromhome.Wehavemanyshoppingsiteson internet likeamazon.com, Dealsglobe.cometc. People
also use the internet to auction goods. There are many auction sites online, where anything
can be sold.

6) Entertainment:

Oninternetwecanfindallformsofentertainmentfromwatchingfilmstoplayinggamesonline.
Almostanyone canfind the right kind of entertainmentfor themselves.When people surf the Web,
there are numerous things that can be found. Music, hobbies, news and more can be found and
shared on the Internet. There are numerous games that may be downloaded from the Internet
for free.

7) E-Commerce:

Ecommerce is the concept used for any type of commercial maneuvering, or business deals
that involvesthe transferof informationacrossthe globe via internet. It hasbecomea
phenomenonassociatedwithanykindofshopping,almostanything.Ithasgotarealamazing and
range of products from household needs, technology to entertainment.

8) Services:

Many services are now provided on the internet such as online banking, job seeking,
purchasingticketsforyourfavoritemovies,andguidanceservicesonarrayoftopicsinthe every aspect
of life, and hotel reservations and bills paying. Often these services are not available off-line
and can cost you more.

9) Job Search:

Internetmakeslifeeasyforbothemployersandjobseekersasthereareplentyofjobsiteswhich connect
employers and job seekers.



10) Dating/Personals:

People are connecting with others though internet and finding their life partners. Internet not
onlyhelps tofindthe right personbut alsotocontinue the relationship.

E-mailing

Short for electronic mail, e-mail or email is text messages that may contain files, images, or
otherattachmentssentthroughanetworktoaspecifiedindividualorgroupofindividuals.The first e-
mail was sent by Ray Tomlinson in 1971. By 1996, more electronic mail was being sent than
postal mail.

“Email,e-mailorelectronicmailisthetransmissionofmessages(emailsoremail messages)
over electronic networks like the internet.”

Email,sometimeswrittenase-mail,issimplytheshortenedformof―electronicmail,‖asystem
forreceiving,sending,andstoringelectronicmessages.Ithasgainednearlyuniversalpopularity
aroundtheworldwiththespreadoftheInternet.Inmanycases,emailhasbecomethepreferred method
for both personal and business communication.

HowItIsUsed

Messages sent by electronic mail normally reach a recipient‘s account within seconds. They
frequentlyincludemorethanjusttext;imagesandnumeroustypesofformatteddocumentsare
noweasilyincludedasattachedfiles.Moreover,itisnolongernecessarytobesittinginfrontof a PC to
send or receive an email. A variety of mobile devices, such as tablet computers and smart
phones, make it possible manage correspondence on the go.

Moste-mailsystemsincludearudimentarytexteditorforcomposingmessages,butmanyallow you to
edit your messages using any editor you want. You then send the message to the
recipientbyspecifyingthe recipient'saddress.You canalso sendthesame message to several users
at once. This is called broadcasting.

Sentmessagesarestoredinelectronicmailboxesuntiltherecipientfetchesthem.Toseeifyou have any
mail, you may have to check your electronic mailbox periodically, although many systems alert
you when mail is received. After reading your mail, you can store it in atext file,
forwardittootherusers,ordeleteit.Copiesofmemoscanbeprintedoutonaprinterifyouwant a paper
copy. E-mail can be distributed to lists of people as well as to individuals. A shared distribution
list can be managed by using an e-mail reflector. Some mailing lists allow you to
subscribebysendingarequesttothemailinglistadministrator.Amailinglistthatisadministered
automaticallyis called a list server. To get a grasp of what email is it's best — the terminology
indicates it — to think in equivalents of "traditional" postal mail.

http://www.wisegeek.com/what-is-business-communication.htm
http://www.webopedia.com/TERM/E/editor.html
http://www.webopedia.com/TERM/B/broadcast.html
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• The email message - Instead of using a pen to write a letter on paper, you're using your
keyboard to type an email message in an email program on your computer.

• Sending the email - When the email is finished and has been addressed to the recipient's
emailaddress,youdon'tputastamponitandpostitbutpressthe Send buttonintheemail program.
This makes the email message go on its journey.

• Email transport - Like postal services transport letters and parcel, emailserverstransmit
email messages from sender to recipient. Usually, emails are not delivered to the recipient
directly,though,butwaitingatthe"nearest"mailservertobepickedupbythem.

• Fetchingnewmail-Ifyou'vegotnewmailinyourmailbox,yougoandfetchit.Similarly,your
emailprogramcancheckfornewemailmessagesatyourmailserveranddownloadthemfor you to
read.

http://email.about.com/od/emailclients/
http://email.about.com/library/glossary/bldef_email_server.htm
http://email.about.com/library/glossary/bldef_email_server.htm
http://email.about.com/cs/standards/a/smtp.htm
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